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要想访问上百个并且不断增多的 PSoC 代码示例列表，请访问我们的代码示例网页。您也可以通过这里，观看 PSoC 4

视频库。 

 

AN79953 介绍了 PSoC® 4，一个基于 Arm® Cortex®-M0/M0+的可编程片上系统。它帮助您了解 PSoC 4 架构及各种开

发工具，并且它也展示了如何使用 PSoC Creator™（即为 PSoC 4 的一种开发工具）来构建您的第一个项目。此外，本

应用手册还向您提供了更多的资源，用以加快深入学习有关 PSoC 4 的知识。 
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1 简介 

PSoC 4 是真正的可编程嵌入式片上系统，在同一芯片中集成了自定义的模拟和数字外设功能、存储器以及 Arm 

Cortex-M0 或 Cortex-M0+微控制器。 

这样的系统和大部分混合信号嵌入式系统不完全一样，它们使用了一个微控制器单元（MCU）和外部模拟和数字外设

的组合。除 MCU 外，这种系统通常还需要多个集成电路，如运算放大器、模数转换器（ADC）和专用的集成电路

（ASIC）。 

PSoC 4 提供了一个低成本的备用方案，该方案可以替代一般的 MCU 加外部集成电路（IC）的组合方案。它的可编程

模拟和数字子系统不仅可以降低整个系统成本，而且还支持极为灵活地调整设计，使产品快速上市。 

PSoC 4 中的电容式触摸感应特性，称为 CapSense®，能提供前所未有的信噪比、一流的防水性能以及支持各种类型

的传感器，如按键、滑条、触控板和接近传感器。 

PSoC 4 的一流功耗性能可以在仍保持 SRAM 数据、可编程逻辑以及响应中断唤醒的前提下仅消耗低达 150 nA 的电

流。非数据保持的电源模式下，在保持该唤醒功能时，PSoC 4 只会消耗 20 nA 的电流。 

http://www.cypress.com/
http://www.cypress.com/documentation/application-notes/an54181-getting-started-psoc-3
http://www.cypress.com/documentation/application-notes/an77759-getting-started-psoc-5lp
http://www.cypress.com/products/psoc-creator-integrated-design-environment-ide
http://www.cypress.com/go/AN79953
http://www.cypress.com/documentation/code-examples/psoc-345-code-examples
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PSoC 4 系列器件还包括 PSoC 4 BLE，它集成了一个低功耗蓝牙（BLE）射频系统。更多有关 PSoC 4 BLE 的详细 

信息，请参考 AN91267。 

文档的使用 

接下来的几页描述了 PSoC 4，以及使用 PSoC 和 PSoC Creator 进行设计的优势。您也可以直接进入并快速构建简单

的设计–转到我的第一个 PSoC 4 设计。 

2 PSoC 资源 

在赛普拉斯网站 www.cypress.com 上提供了大量的资料，这些资料有助于选择符合您设计的 PSoC 器件，并使您能够

快速有效地将器件集成到设计中。有关使用资源的完整列表，请参考 KBA86521 — 如何使用 PSoC 3、PSoC 4 和

PSoC 5LP 进行设计。下面提供了 PSoC 4 的简要列表： 

▪ 概况：PSoC 产品系列、PSoC 蓝图 

▪ 产 品 选 型 ： PSoC 1 、 PSoC 3 、 PSoC 4, 

PSoC 5LP 或 PSoC 6 MCU。此外，PSoC 

Creator 还包含了一个器件选择工具。 

▪ 数据手册：描述并提供了适用于 PSoC 4000、

PSoC 4100、PSoC 4200、 PSoC 4xx7 BLE、

PSoC 4100M、 PSoC 4200M、PSoC 4200-L、 

PSoC 4000S、PSoC 4100S、PSoC 4100PS

和 PSoC 4100S Plus器件的电器规范。 

▪ CapSense 设计指南：了解如何在 PSoC 4 器

件系列中设计电容式触摸感应应用。欲更多了

解 CapSense 技术的信息，请参考应用手册

AN64846 - CapSense®入门。  

▪ 应用手册和代码示例涵盖了广泛的主题，从初

级到高级水平。PSoC Creator 为您提供了更

多的代码示例，请参考代码示例。 

▪ 技术参考手册（TRM）：对每个 PSoC 4 器件系列

中所使用的架构和寄存器进行了详细说明。 

▪ PSoC 培训视频：这些视频一步一步介绍了使用

PSoC 构建复杂设计的流程。 

▪ 开发套件: 

 CY8CKIT-040、CY8CKIT-041、CY8CKIT-

042、CY8CKIT-044、CY8CKIT-046 和

CY8CKIT-042-BLE 的各种 PSoC 4 Pioneer 套

件均为易于使用且廉价的开发平台。 

这些套件包括用于 Arduino 兼容扩展板和

Digilent® Pmod™子卡的连接器。 

 CY8CKIT-043 、 CY8CKIT-049 、 CY8CKIT-

145、CY8CKIT-147 和 CY8CKIT-149 都是成

本非常低的原型平台，用于 PSoC 4200 器件

采样。 

▪ MiniProg3 器件提供一个用于进行闪存编程和调试

的接口。 

2.1 PSoC Creator 

PSoC Creator 是一个基于 Windows 的免费集成开发环境（IDE）。通过它可以同时在 PSoC 3、PSoC 4、PSoC 5LP 

和 PSoC 6 MCU 的系统中设计硬件和固件。如图 1 所示：通过 PSoC Creator，您可以进行以下操作： 

1. 拖放组件图标，以进行您的硬件系统设计 

2. 协作设计您的应用固件和 PSoC 硬件 

3. 使用配置工具配置各组件 

4. 研究包含 100 多个组件的库 

5. 查看组件数据手册 

http://www.cypress.com/
http://www.cypress.com/documentation/application-notes/an91267-getting-started-psoc-4-ble
http://www.cypress.com/
http://www.cypress.com/?id=4&rID=77024&source=an79953
http://www.cypress.com/?id=4&rID=77024&source=an79953
http://www.cypress.com/psoc
http://www.cypress.com/product-roadmaps/cypress-platform-psoc-solutions-roadmap
http://www.cypress.com/products/psoc-1
http://www.cypress.com/products/psoc-3
http://www.cypress.com/products/psoc-4
http://www.cypress.com/products/psoc-5lp
http://www.cypress.com/products/32-bit-arm-cortex-m4-psoc-6
http://www.cypress.com/documentation/datasheets/psoc-4-psoc-4000-family-datasheet-programmable-system-chip-psoc
http://www.cypress.com/documentation/datasheets/psoc-4-psoc-4100-family-datasheet-programmable-system-chip-psoc
http://www.cypress.com/documentation/datasheets/psoc-4-psoc-4200-family-datasheet-programmable-system-chip-0
http://www.cypress.com/documentation/datasheets/psocr-4-psoc-4xx7ble-family-datasheet-programmable-system-chip-psocr-zh
http://www.cypress.com/documentation/datasheets/psoc-4-psoc-4100m-family-datasheet
http://www.cypress.com/documentation/datasheets/psocr-4-psoc-4200m-family-datasheet-programmable-system-chip-psocr-ja
http://www.cypress.com/documentation/datasheets/psocr-4-psoc-4200-l-family-datasheet-programmable-system-chip-psocr?source=search&cat=technical_documents
http://www.cypress.com/documentation/datasheets/psocr-4-psoc-4000s-family-datasheet-programmable-system-chip-psoc
http://www.cypress.com/documentation/datasheets/psocr-4-psoc-4100s-family-datasheet-programmable-system-chip-psoc
http://www.cypress.com/documentation/datasheets/psocr-4-psoc-4100ps-family-datasheet-programmable-system-chip-psoc
http://www.cypress.com/documentation/datasheets/psocr-4-psoc-4100ps-family-datasheet-programmable-system-chip-psoc
http://www.cypress.com/documentation/datasheets/psocr-4-psoc-4100s-premium-family-datasheet-programmable-system-chip-psoc
http://www.cypress.com/documentation/application-notes/an85951-psoc-4-and-psoc-analog-coprocessor-capsense-design-guide
http://www.cypress.com/documentation/application-notes/an64846-getting-started-capsense
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=76&id=4749
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=117&id=4749&applicationID=0&l=0
http://www.cypress.com/video-library/PSoC
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=110&id=4749&applicationID=0&l=0
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-040-psoc-4000-pioneer-development-kit
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-041-psoc-4-s-series-pioneer-kit
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-042-psoc-4-pioneer-kit
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-042-psoc-4-pioneer-kit
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-044-psoc-4-m-series-pioneer-kit
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-046-psoc-4-l-series-pioneer-kit
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-042-ble-bluetooth-low-energy-ble-pioneer-kit
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-043-psoc-4-m-series-prototyping-kit
http://www.cypress.com/documentation/development-kitsboards/psoc-4-cy8ckit-049-4xxx-prototyping-kits
http://www.cypress.com/CY8CKIT-145
http://www.cypress.com/CY8CKIT-145
http://www.cypress.com/CY8CKIT-147
http://www.cypress.com/CY8CKIT-149
http://www.cypress.com/go/cy8ckit-002
http://www.cypress.com/psoccreator/?source=an79953
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图 1. PSoC Creator 特性 

 

http://www.cypress.com/
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2.2 代码示例 

PSoC Creator 包含了多个代码示例项目。可以从 PSoC Creator

的“Start Page” （起始页）上获取这些项目，如图 2 所示。 

这些示例项目通过为您提供完整的设计（并非一个空白页），可

以加快您的设计过程。示例项目还介绍了如何将 PSoC Creator 组

件使用于不同应用中。此外，它还包含了多个代码示例和数据 

手册，如图 3 所示。 

在图 3 所示的 Find Example Project（查找示例项目）对话框中，

您可以选择以下选项： 

▪ 根据 architecture（架构）或 device family（器件系列）（例

如：PSoC 3、PSoC 4、PSoC 5LP 或 PSoC 6 MCU）、

category（类型）或 keyword（关键词）等选项对示例进行筛

选 

▪ 从 Filter Options（滤波选项）的示例菜单中进行选择 

▪ 通过 Documentation（文档）选项卡，查看所选的数据手册 

▪ 查看所选的代码示例。您可以复制该窗口中的代码然后将其

粘贴到您的项目内，从而加快代码的开发过程或 

▪ 根据已选项目创建一个新的项目（若需要，可添加新的工作

区）。通过为您提供一个完整的基本设计，它可以加快您的

设计进程。然后，您可以将该设计适用于您的应用中。 

图 2. PSoC Creator 中的代码示例 

 

图 3. 带样本代码的代码示例项目 

 

 

http://www.cypress.com/
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2.3 PSoC Creator 帮助 

请访问 PSoC Creator 主页以下载 PSoC Creator 的最新版本。启动 PSoC Creator，并导航到下列各项： 

▪ 快速入门指南：依次选择 Help > Documentation > Quick Start Guide。本指南提供了开发 PSoC Creator 项目

的基本知识。 

▪ 简单组件的示例项目：依次选择 File > Open > Example projects。这些示例项目展示了如何配置及使用 PSoC 

Creator 组件。 

▪ 系统参考指南：依次选择 Help > System Reference > System Reference Guide。该指南列出并描述了 PSoC 

Creator 提供的系统功能。 

▪ 组件数据手册：右键单击组件，然后选择“Open Datasheet”项。请访问 PSoC 4 组件的数据手册网页，获取所有

PSoC 4 组件的数据手册列表。 

▪ PSoC 培训视频：这些视频介绍了 PSoC Creator 入门的过程。 

▪ 文档管理器：PSoC Creator 提供了一款文档管理工具，便于寻找和查看文件资源。要想打开文档管理工具，请选

择菜单项 Help >Document Manager。 

2.4 技术支持 

若有任何疑问，我们的技术支持团队很乐意为您提供帮助。您可以在赛普拉斯技术支持页面上创建一个技术支持请求。 

如果您在美国，可以通过拨打我们的免费电话，直接与技术支持团队联系：+1-800-541-4736。在提示符处选择第 8

项。 

若想快速获得支持，您同样可以使用下面的支持资源。 

▪ 自助 

▪ 所在地销售办事处 

http://www.cypress.com/
http://www.cypress.com/?id=2494&source=an79953
http://www.cypress.com/?id=4749&rtID=377
http://www.cypress.com/?app=search&searchType=advanced&keyword=&rtID=377&id=4749&source=an79953
http://www.cypress.com/video-library/PSoC-Software
https://secure.cypress.com/myaccount/?id=25&techSupport=1&source=an79953
http://www.cypress.com/support
http://www.cypress.com/support
http://www.cypress.com/?id=1062
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3 PSoC 4 的功能集 

PSoC 4 具有一个丰富的功能集，包括一个 CPU 和存储器子系统、一个数字子系统、一个模拟子系统以及全部系统资

源，如图 4 所示。下面各节对每个特性进行了简要说明。更多有关信息，请查看 PSoC 资源罗列的 PSoC 4 系列器件

的数据手册、技术参考手册（TRM）和应用手册。 

图 4. PSoC 4 架构（PSoC 4200L） 
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表 1 显示的是不同 PSoC 4 器件系列具有的资源。根据不同的器件，可能支持全部或部分这些特性。更多有关信息， 

请参考 PSoC 4 产品选型指南。 

http://www.cypress.com/
http://www.cypress.com/?id=4976&source=an79953
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表 1. PSoC 4 器件 

特性 

器件系列 

CY8C4000 CY8C4000S CY8C4100 PSoC 4100S 
PSoC 4100S 

Plus 
PSoC 4100PS CY8C4200 CY8C4200M CY8C4200L PSoC 4500 

CPU 
16 MHz          
Cortex-M0  

带有单周期乘

法功能的 

48 MHz 
Cortex-M0+ 

带有单周期乘法 

功能的 24 MHz 

Cortex-M0 

带有单周期乘

法功能的 

48 MHz 
Cortex-M0+ 

带有单周期乘

法功能的 

48 MHz 
Cortex-M0+ 

带有单周期乘

法功能的 

48 MHz 
Cortex-M0+ 

带有单周期乘

法功能的 

48 MHz 
Cortex-M0 

带有单周期乘

法功能的 

48 MHz 
Cortex-M0 

带有单周期乘

法功能的 48 

MHz Cortex-
M0 

带有单周期

乘法功能的 

48 MHz 
Cortex-M0+ 

DMA 无 无 无 无 8 个通道 8 个通道 无 8 个通道 32 个通道 8 个通道 

闪存 16 KB 32 KB 32 KB 64 KB 128 KB 32 KB 32 KB 128 KB 256 KB 256 KB 

SRAM 2 KB 4 KB 4 KB 8 KB 16 KB 4 KB 4 KB 16 KB 32 KB 32 KB 

GPIO 数量 20 36 36 36 54 38 36 55 96  54 

CapSense 16 个传感器 35 个传感器 35 个传感器 35 个传感器 53 个传感器 33 个传感器 35 个传感器 54 个传感器 94 个传感器 N/A 

ADC 无 

10 位、

46 ksps 单斜
ADC 

带有定序器的 12

位、806 ksps 

SAR ADC 

带有定序器的

12 位、 

1 MSPS SAR 
ADC 

带有定序器的

12 位、 

1 MSPS SAR 
ADC 

12 位, 1MSPS 

扫描 SAR 

ADC 

带有定序器的

12 位、 

1 Msps SAR 
ADC 

带有定序器的

12 位、 

1 Msps SAR 
ADC 

带有定序器的

12 位、 

1 Msps SAR 
ADC 

2 个带有定序

器的 12 位、 

1 Msps SAR 
ADC 

运算放大器/可

编程增益放大

器（PGA） 

无 无 
两个可编程的运

算放大器 

两个可编程的

运算放大器 

两个可编程的

运算放大器 

四个可编程的

运算放大器
/PGA 

两个可编程的

运算放大器 

两个可编程的

运算放大器 

4 个可编程的

运算放大器 

三个可编程

的运算放大

器 

可编程电压参

考 (PVref) 
无 无 无 无 无 四通道 无 无 无 无 

电压 DAC 

(VDAC) 
无 无 无 无 无 13 位 VDAC 无 无 无 无 

比较器 

一个具有固

定阈值 

（1.2 V）的

CSD 比较器 

两个具备唤醒

功能的低功耗

比较器 

两个具备唤醒功

能的低功耗比较

器 

两个具备唤醒

功能的低功耗

比较器 

两个具备唤醒

功能的低功耗

比较器 

两个具备唤醒

功能的低功耗

比较器 

两个具备唤醒

功能的低功耗

比较器 

两个具备唤醒

功能的低功耗

比较器 

两个具备唤醒

功能的低功耗

比较器 

两个具备唤

醒功能的低

功耗比较器 

IDAC1 

一个 7 位和

一个 8 位的
IDAC 

两个 7 位的
IDAC 

一个 7 位和一个 

8 位的 IDAC 

两个 7 位的
IDAC 

两个 7 位的
IDAC 

两个 7 位的
IDAC 

一个 7 位和一

个 8 位的
IDAC 

两个 7 位和两

个 8 位的
IDAC 

两个 7 位和两

个 8 位的
IDAC 

无 

                                            
1 只有 CapSense 功能被禁用时才能使用 IDAC。有关详细信息，请参见 PSoC 4 技术参考手册。 

http://www.cypress.com/
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特性 

器件系列 

CY8C4000 CY8C4000S CY8C4100 PSoC 4100S 
PSoC 4100S 

Plus 
PSoC 4100PS CY8C4200 CY8C4200M CY8C4200L PSoC 4500 

可编程逻辑模

块（UDB） 
无 无 无 无 无 无 

具有四个

UDB，每个

UDB 包括 

8 个宏单元和

1 个数据路径 

具有四个

UDB，每个

UDB 包括 

8 个宏单元和

1 个数据路径 

具有八个

UDB，每个

UDB 包括 

8 个宏单元和

1 个数据路径 

无 

智能 IO 

端口 
无 

两个智能 IO

端口 
无 

两个智能 IO 

端口 

两个智能 IO 

端口 
1 无 无 

一个智能 IO

端口 
2 

电源电压 

范围 

1.71 V 至
5.5 V 

1.71 V 至.5 V 1.71 V 至 5.5 V 1.71 V 至.5 V 1.71 V 至.5 V 1.71 V 至.5 V 
1.71 V 至 

5.5 V 

1.71 V 至 

5.5 V 

1.71 V 至 

5.5 V 
1.71 V 至.5 V 

低功耗模式 

在深度睡眠

模式中， 

电流消耗为
2.5 µA 
 

在深度睡眠模

式中， 

电流消耗为
2.5 µA 

在深度睡眠模

式、休眠模式和

停止模式中， 

电流消耗分别为

1.3 µA、150 nA

和 20 nA 

在深度睡眠模

式中，电流消

耗为 2.5 µA 

在深度睡眠模

式中，电流消

耗为 2.5 µA 

在深度睡眠模

式中，电流消

耗为 2.5 µA 

在深度睡眠模

式、休眠模式

和停止模式

中，电流消耗

分别为 

1.3 µA、 

150 nA 和 

20 nA 

在深度睡眠模

式、休眠模式

和停止模式

中，电流消耗

分别为 

1.3 µA、 

150 nA 和 

20 nA 

在深度睡眠模

式、休眠模式

和停止模式

中，电流消耗

分别为 1.3 

µA、 

150 nA 和 

20 nA 

在深度睡眠

模式、休眠

模式和停止

模式中，电

流消耗分别

为 

1.3 µA、 

150 nA 和 

20 nA 

段式 LCD 驱动 无 
四个 COM 段

式 LCD 驱动 

四个 COM 段式

LCD 驱动 

四个 COM 段

式 LCD 驱动 

四个 COM 段

式 LCD 驱动 

四个 COM 段

式 LCD 驱动 

四个 COM 段

式 LCD 驱动 

四个 COM 段

式 LCD 驱动 

八个 COM 段

式 LCD 驱动 
无 

串行通信 一个 I2C 

两个串行通信

模块

（SCB），可

将其配置为

I2C、SPI 或
UART 

两个 SCB，可将

其配置为 I2C、

SPI 或 UART 

三个 SCB，可

将其配置为

I2C、SPI 或
UART 

5 个 SCB，可

将其配置为

I2C、SPI 或
UART 

三个 SCB，可

将其配置为

I2C、SPI 或
UART 

两个 SCB，可

将其配置为

I2C、SPI 或
UART 

两个 SCB，可

将其配置为

I2C、SPI 或
UART 

四个 SCB，可

将其配置为

I2C、SPI 或
UART 

五个 SCB，

可将其配置

为 I2C、SPI

或 UART 

定时计数脉宽

调制器

（TCPWM） 

1 5 4 5 8 8 4 8 8 8 

控制器区域网

络（CAN） 
无 无 无 无 1 无 无 2 2 无 

通用串行总线

（USB） 
无 无 无 无 无 无 无 无 

具有 8 个端点

的全速 USB

器件 

无 

http://www.cypress.com/
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特性 

器件系列 

CY8C4000 CY8C4000S CY8C4100 PSoC 4100S 
PSoC 4100S 

Plus 
PSoC 4100PS CY8C4200 CY8C4200M CY8C4200L PSoC 4500 

马达控制加速 

(MCA) 
无 无 无 无 无 无 无 无 无 2 

时钟  

内部主振荡

器（IMO）

的频率为 

24 MHz/ 
32 MHz  

内部低速振

荡器

（ILO）的

频率为 

32 KHz 

IMO 的频率为

24 MHz 到 

48 MHz   

ILO 的频率为
40 kHz  

监视晶振

（WCO）的频

率为 32 kHZ 

IMO 的频率为 

3 MHz 到 

24 MHz  

ILO 的频率为 

32 kHz 

IMO 的频率为

24 MHz 到 

48 MHz   

ILO 的频率为
40 kHz  

WCO 的频率

为 32 kHZ 

IMO 的频率为

24 MHz 到 

48 MHz   

ILO 的频率为
40 kHz  

WCO 的频率

为 32 kHZ 

IMO 的频率为

24 MHz 到 

48 MHz   

ILO 的频率为
40 kHz  

WCO 的频率

为 32 kHZ 

IMO 的频率为

3 MHz 到 

48 MHz 

ILO 的频率为
32 kHz 

IMO 的频率为

3 MHz 到 

48 MHz 

ILO 的频率为 

32 kHz 

WCO 的频率

为 32 KHz 

IMO 的频率为

3 MHz 到
48 MHz 

外部晶振

（ECO）的频

率为 

4 MHz 到 

33 MHz 

ILO 的频率为 

32 kHz 

WCO 的频率

为 32 KHz 

IMO 的频率

为 3 MHz 到 

48 MHz 

ILO 的频率为 

32 kHz 

WCO 的频率

为 32 KHz 

电源监控 

上电复位

（POR） 

欠压检测

（BOD） 

POR、BOD 

POR、BOD、  

低压检测

（LVD） 

POR、BOD POR、BOD POR, BOD 
POR、BOD、
LVD 

POR、BOD、
LVD 

POR、BOD、
LVD 

POR, BOD, 
LVD 

支持套件 
CY8CKIT-
040 Pioneer 
kit 

CY8CKIT-041 
Pioneer kit 

CY8CKIT-049 
Prototyping Kit 

CY8CKIT-041 
Pioneer kit 

CY8CKIT-149 
Prototyping Kit 

CY8CKIT-147 
Prototyping Kit 

CY8CKIT-042 
Pioneer kit 

CY8CKIT-044 
Pioneer kit 

CY8CKIT-046 
Pioneer kit 

无 

 

http://www.cypress.com/
http://www.cypress.com/CY8CKIT-040&source=an79953
http://www.cypress.com/CY8CKIT-040&source=an79953
http://www.cypress.com/CY8CKIT-041
http://www.cypress.com/?rID=92146&source=an79953
http://www.cypress.com/CY8CKIT-041
http://www.cypress.com/cy8ckit-149
http://www.cypress.com/cy8ckit-147
http://www.cypress.com/cy8ckit-147
http://www.cypress.com/CY8CKIT-042
http://www.cypress.com/CY8CKIT-044
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-046-psoc-4-l-series-pioneer-kit


  PSoC 4入门 

www.cypress.com 文档编号：001-87170 版本*I 10 

4 PSoC 的性能比 MCU 的更优越 

图 5 显示了一款典型的 MCU，它包含一个 CPU （如：8051 或 ARM Cortex），并且具有一系列外设功能（如：

ADC、DAC、UART、SPI 和通用 I/O），所有这些器件都与 CPU 的寄存器接口相连。在某个内部 MCU 中，可以将

CPU 称为该器件的“心脏” — 由于它监控着器件的所有活动，包括设置数据移动和时序。如果没有 CPU，那么该 MCU

便不能执行其性能。 

 

 

 

图 6 显示的是 PSoC 又存在差别。在可编程系统 PSoC 中，CPU、模拟、数字和 I/O 都是同样重要的资源。PSoC 的
“心脏”是系统的互联和可编程性，并不是 CPU。外设模拟和数字通过高度可编程信号矩阵和数据总线网络互相连接，

用以创建符合您应用要求的自定义设计。所以，您可以通过编程 PSoC 来模拟 MCU，但不能通过编程 MCU 来模拟
PSoC。 

图 5. 典型 MCU 的结构框图 

 

 

 

 

 

图 6. PSoC 框图 
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典型的 MCU 要求 CPU 固件处理各种状态机制、使用定时器来进行计时，并驱动一个输出引脚。因此，其功能路径几

乎都是通过 CPU 实现的。通过使用 PSoC，可以进行异步并行操作。您可以配置 PSoC 中的组件，使其运行独立于

CPU。本应用手册中的项目详细说明了这个概念。配置 PSoC，使其不需要向 CPU 写入任何代码也能实现 LED 闪烁。 

4.1 PSoC Creator 组件定义 

PSoC 的另一个重要特性是支持 PSoC Creator IDE。在 PSoC Creator 中，不同的 PSoC 资源被组织为各个图形元素

（又称组件），可以将这些组件拖放到原理图内，从而快速进行设计。PSoC 中的所有外设都可作为预验证的 PSoC 

Creator 组件，包括：PWM、ADC、DAC、CapSense、UART 等组件。在 PSoC Creator 中使用预验证组件能够明显

缩短开发时间，并且还可以通过使用各个图形选项来快速更改设计。 

例如，要想在典型的微控制器中配置 PWM 使 LED 闪烁发亮，则需要执行以下操作： 

1. 确定对应于 PWM 模块的存储器的位置。 

2. 根据所需 PWM 周期和占空比，计算需要写入到 PWM 寄存器内的值。 

3. 编程，以便配置 PWM 寄存器，设置引脚驱动模式，并将 PWM 输出连接到该引脚上。许多 MCU 没有提供用于连

接到内部模块的备用引脚。 

实现同 PSoC 的相同功能非常重要，您可以在本应用手册的下面各节中找到相关内容。如果您需要将同样的 PWM 模块

重新配置为一个定时器，则只要在 PSoC Creator 中轻点几下鼠标便可！ 

PSoC 也具有可编程数字模块，被称为通用数字模块（UDB）。PSoC Creator 还提供了多个由 UDB 模块构成的组件，

如：UART、SPI、I2S、定时器、PWM、计数器、数字门控（AND、OR、NOT、XOR）等。通过使用 PSoC Creator

中的 UDB，您甚至可以创建自己的自定义状态机和数字逻辑。欲了解该方法，请参考 PSoC® Creator™ 组件创建指

南。 

http://www.cypress.com/
http://www.cypress.com/documentation/component-datasheets/psoc-creator-component-author-guide
http://www.cypress.com/documentation/component-datasheets/psoc-creator-component-author-guide
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5 我的第一个 PSoC 4 设计 

该部分涵盖以下内容： 

▪ 演示了如何编程 PSoC，使其性能比传统 MCU 的更优越 

▪ 说明了如何创建简单的 PSoC 设计，并将其安装在一个开发套件中 

▪ 介绍了了解 PSoC 设计技术的详细快捷步骤，以及使用 PSoC Creator 的方式 

5.1 入门 

5.1.1 您是否已经安装了 PSoC Creator？  

在 PSoC Creator 主页上下载并安装 PSoC Creator。请注意，安装该工具集可能需要较长时间，具体情况请参考

PSoC Creator 的发布说明。 

5.1.2 您是否有一个开发套件或原型套件？  

测试该设计需要使用表 2 中所列出的一个套件，它具有一个集成的编程器。  

表 2. PSoC 4 Pioneer 套件、原型套件和受支持器件列表 

套件名称 套件类型 受支持器件系列 器件型号 

CY8CKIT-040 Pioneer 套件 PSoC 4000 CY8C4014LQI-422 

CY8CKIT-041 Pioneer 套件 PSoC 4000S CY8C4045AZI-S413  

CY8CKIT-041 Pioneer 套件 PSoC 4100S CY8C4146AZI-S433 

CY8CKIT-042 Pioneer 套件 PSoC 4200 CY8C4245AXI-483 

CY8CKIT-044 Pioneer 套件 PSoC 4200M CY8C4247AZI-M485 

CY8CKIT-046 Pioneer 套件 PSoC 4200L CY8C4248BZI-L489 

CY8CKIT-042-BLE Pioneer 套件 PSoC 4200 BLE CY8C4247LQI-BL483 

CY8CKIT-043 原型套件 PSoC 4200M CY8C4247AZI-M485 

CY8CKIT-049 

 

原型套件 PSoC 4200 CY8C4245AXI-483 

PSoC 4100 CY8C4125AXI-483 

CY8CKIT-145 原型套件 PSoC 4000S CY8C4045AZI-S413 

CY8CKIT-147 原型套件 PSoC 4100PS CY8C4145LQI-PS433 

CY8CKIT-149 原型套件 PSoC 4100S Plus CY8C4147AZI-S475 

 

如果您已经拥有上述任意套件，请跳到第一部分：构建设计。 

如果您正在使用的是 CY8CKIT-049（其包含 USB 串行 Bootloader 而不是编程器），请使用本应用手册所提供的

CY8CKIT_049_Example。您可以从 AN79953 登陆页上下载它，被作为 AN79953.zip 的一部分。欲了解如何将该示例

项目引导加载到您的 CY8CKIT-049 中，请参考引导加载 CY8CKIT-049 一节。  

您同样可以评估该套件所提供的代码示例，并非该设计。更多有关信息，请参考该套件指南中“代码示例”部分内容。

请访问 CY8CKIT-049 套件的网址，下载相关的套件指南和代码示例。  

5.1.3 您是否想查看正在操作的项目？  

若不想进行整个设计过程，则可以在 http://www.cypress.com/go/AN79953 网站上下载完整的 PSoC Creator 项目，然

后可以跳转到创建和编程步骤。 

http://www.cypress.com/
http://www.cypress.com/go/creator
http://www.cypress.com/CY8CKIT-040&source=an79953
http://www.cypress.com/CY8CKIT-041
http://www.cypress.com/CY8CKIT-041
http://www.cypress.com/CY8CKIT-042
http://www.cypress.com/CY8CKIT-044
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-046-psoc-4-l-series-pioneer-kit
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-042-ble-bluetooth-low-energy-ble-pioneer-kit
http://www.cypress.com/documentation/development-kitsboards/cy8ckit-043-psoc-4-m-series-prototyping-kit
http://www.cypress.com/?rID=92146&source=an79953
http://www.cypress.com/cy8ckit-145
http://www.cypress.com/cy8ckit-147
http://www.cypress.com/cy8ckit-149
http://www.cypress.com/?rID=92146&source=an79953
http://www.cypress.com/?rID=78695&source=an79953
http://www.cypress.com/?rID=92146&source=an79953
http://www.cypress.com/documentation/development-kitsboards/psoc-4-cy8ckit-049-4xxx-prototyping-kits
http://www.cypress.com/go/AN79953
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5.2 设计概况 

该设计通过使用 TCPWM 组件点亮两个 LED，如图 7 所示。在 PWM 模式下配置 TCPWM。该 PWM 的两个互补输出

控制 LED。PWM 在超低频率和占空比为 50%的条件下运行时，可以观察到 LED 的切换。如果您使用的是双色 LED 而

不是两个单独的 LED，该项目可切换双色 LED 的颜色。 

图 7. 我的第一个 PSoC 4 设计 

 

5.3 第一部分：构建设计 

本节向您逐步介绍了设计的流程。首先是构建一个空白项目，然后指导您通过硬件和固件设计。  

1. 启动 PSoC Creator，然后从 File 菜单中依次选择 New > Project，如图 8 所示。 

图 8. 创建新项目 

 

2. 在弹出窗口中选择您的开发套件。例如，如果您正在使用 CY8CKIT-042，请选择 Kit: CY8CKIT-042 (PSoC 4100/ 

PSoC 4200)，然后点击 Next 按键。如果在菜单中没有找到 PSoC 4 开发套件，请从赛普拉斯网站上下载并安装

它。  

另外，您也可以先选中目标器件单选按键（并非目标硬件）然后再选择相应的器件，并点击 Next。 

http://www.cypress.com/
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图 9. 创建新的空 PSoC 4 项目 

 

3. 从以下窗口中选择 Empty Schematic（空白原理图），并点击 Next。 

图 10. 选择空白原理图 

 

http://www.cypress.com/
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4. 为工作区和项目命名（如“My_First_Project”）， 如下图所示。为新项目选择相应的位置，然后点击 Finish。  

 

5. 创建新项目时，将在 Workspace Explorer（工作区浏览器）中生成一个含有基本文件目录的项目文件夹（如 

图 11 所示）。双击 TopDesign.cysch，即可打开项目原理图文件。 

图 11. 打开 TopDesign 原理图 

 

http://www.cypress.com/
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6. 将 Component Catalog（组件目录）中的一个 PWM (TCPWM Mode)组件拖放到该原理图中，如图 12 所示。 

图 12. PWM 组件的位置 

 

7. 双击原理图上的 PWM 组件，进行配置组件的属性，如图 13 所示。单击 PWM 选项卡，分别将“Period”（周期

值）设置为 254、“Compare”（比较值）设置为 127，以生成占空比为 50%的 PWM 信号。 

Prescaler（预分频器）设置为 8x，以将输入时钟频率除以 8。 

图 13. PWM 组件的配置 

 

http://www.cypress.com/
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8. 运行 PWM 时需要一个输入时钟提供时钟脉冲。将 Clock（时钟）组件拖放到原理图中，并通过双击该组件将

Frequency（频率）配置为 800 Hz，如图 14 和图 15 所示。  

因为 PWM 组件中所设置的预分频器值为 8，PWM 的有效输入时钟仅为 100 Hz。因此，PWM 的周期值为 254 导

致其输出时间周期为 2.54 秒。 

图 14. 时钟组件的位置 

 

 

图 15. 时钟组件的配置 

 

http://www.cypress.com/
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9. 拖放 Digital Output Pin（数字输出引脚）组件。将其名称改为 LED_1，如图 16 和图 17 所示。添加另一个数字

输出引脚组件，并将其名称改为 LED_2。 

图 16. 数字输出引脚组件的位置 

 

图 17. 重新命名引脚组件 

 

10. 在该原理图窗口中选择连线工具，如图 18 所示，或按下 W 热键。 

图 18. 选择连线工具 

 

http://www.cypress.com/
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11. 将各组件互连在一起，如图 19 所示。 

图 19. 原理图连线 

 

12. 器件复位时，大部分组件均被禁用（时钟组件除外，在默认情况下它会自动启动），要使能它们，您必须将代码添

加到项目中。从 Workspace Explorer 中打开 main.c，并将代码添加到 main()函数内，如代码 1 所示。 

代码 1. 使能 PWM 组件 

int main() 

{ 

  /* Enable and start the PWM */ 

  PWM_1_Start(); 

 

  for(;;) 

  { 

 

  } 

} 

 

13. 从“Build”（创建）菜单中选择 Build My_First_Project。请注意，在 Workspace Explorer 窗口中，PSoC 

Creator 将自动为 PWM、时钟和数字输出引脚等组件生成源代码文件，如图 20 所示。 

http://www.cypress.com/
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图 20. 所生成的源文件 
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14. 从 Workspace Explorer 窗口打开文件 My_First_Project.cydwr（设计范围资源文件），并单击 Pins 选项卡。 

您可以使用该选项卡选择输出 LED_1 和 LED_2 的器件引脚。 

图 21 显示的是 CY8CKIT-042 PSoC 4 Pioneer 套件中将 LED_1 和 LED_2 引脚连接到绿色和红色 LED 的引脚 

配置。如果您使用不同的 PSoC 4 Pioneer 套件，请参考表 3；如果您在使用 PSoC 4 原型套件，请参考表 4。 

图 21. 引脚选择 

  

表 3. 各个 Pioneer 套件上的引脚映射 

功能 
CY8CKIT-040 

（PSoC 4000） 

CY8CKIT-041 

（PSoC 4000S / 

PSoC 4100S） 

CY8CKIT-042 

（PSoC 4200） 

CY8CKIT-042-
BLE 

(PSoC 4200 BLE) 

CY8CKIT-044 

（PSoC 4200M） 

CY8CKIT-046 

（PSoC 4200L） 

绿色 LED 

（低电平有效） 
P1[1] P2[6] P0[2] P3[6] P2[6] P5[3] 

红色 LED 

（低电平有效） 
P3[2]* P3[4]** P1[6] P2[6] P0[6] P5[2] 

 

表 4.跨原型套件引脚映射表 

功能 CY8CKIT-145 (PSoC 4000S) CY8CKIT-149 (PSoC 4100S Plus) 

Green LED - LED 1 (低电平有效)  P3[4] P1[6] 

Green LED - LED 2 (低电平有效) P3[5] P5[7] 

 

*PSoC 4000 器件为互补 PWM 输出配有固定的引脚：P1[1]和 P1[6]。不能将任何其他引脚配置为 PWM 输出。有关详

情，请参见器件数据手册。如果您正在使用 CY8CKIT-040，那么可以将连接至 P1[1]的绿色 LED 作为 LED1。为了将

红色 LED 作为 LED2 使用，您应该使用线缆将 J4 插头上的 P3[2]连接到 J3 插头上的 P1[6]。此外，您还可以将外部

LED 连接至 P1[6]，并将它作为 LED2。 

http://www.cypress.com/
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**类似地，如果您正在使用 CY8CKIT-041，可以将连接至 P2[6]的绿色 LED 作为 LED1，并且将互补 PWM 输出 P2[7]

作为 LED2。要想将红色 LED 作为 LED2 使用时，需要使用线缆将 J2 插头上的 P3[4]和 J3 插头上的 P2[7]连接起来。

此外，您也可以将外部 LED 连接到 P2[7]上，作为 LED2 使用。 

注意：CY8CKIT-043 和 CY8CKIT-049 只有一个 LED 连接着 P1[6]。如果您正在使用 CY8CKIT-049，则可以将一

个外部 LED 连接到 P0[2]上。CY8CKIT-147 只有一个连接到 P0[2]的 LED；您可以连接一个外部 LED 到引脚 

P0[3]。 

15. 最后，根据第 12 步所介绍的内容重建项目。 

16. 如果您使用 CY8CKIT-049，请继续执行以下部分操作。如果您使用 CY8CKIT-049，请跳转到将 CY8CKIT-049 项

目转换为 Bootloadable 项目。 

5.4 第二部分：编程器件 

本部分阐述了如何编程器件。如果您正在使用 CY8CKIT-040, CY8CKIT-041, CY8CKIT-042, CY8CKIT-044, CY8CKIT-

046, CY8CKIT-043, CY8CKIT-049, CY8CKIT-145, CY8CKIT-147 或 CY8CKIT-149 套件，那么需要使用 USB 数据线

将电路板连接到您的电脑上。  

1. 在 PSoC Creator 菜单中，选择 Debug >Select Debug Target，如图 22 所示。 

图 22. 选择调试对象 

 

2. 在 Select Debug Target 对话框中，选择 Port Acquire，然后单击 Connect，如图 23 所示。单击 OK 以关闭对

话框。 

图 23. 连接到器件 

 

3. 通过选择菜单项 Debug > Program，将项目编程到器件中，如图 24 所示。 

图 24. 编程器件 

 

http://www.cypress.com/
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4. 可在状态栏上查看编程状态（窗口的左下角），如图 25 所示。 

图 25. 编程状态 

 

5. 编程完成器件后，通过查看 LED 的切换状态可验证项目的效果。 

5.5 将 CY8CKIT-049 项目转换为 Bootloadable 项目 

1. 从 Workspace Explorer 中双击 TopDesign.cysch，将导航到 TopDesign 原理图中。 

2. 在 Component Catalog（组建目录）中将 Bootloadable 拖放到 TopDesign 原理图内。 

3. 双击 Bootloadable 组件，点击 Dependencies 选项卡，以便从该套件所包含的 UART Bootloader 项目中选择.hex

和.elf 文件（\CY8CKIT-049-42xx\Firmware\SCB_Bootloader\ 

UART_Bootloader.cydsn\CortexM0\ARM_GCC_484\Debug\）。这样会使 bootloadable 项目指向套件中正在运行

的 bootloader。依次点击 Apply 和 OK。 

图 26. 添加 UART Bootloader 的 Dependency（依赖属性） 

 

4. 最后，从 Build 菜单中选择 Build My_First_Project 项，以重新编译项目。 

5.6 引导加载 CY8CKIT-049 

CY8CKIT-049 和其他的 PSoC 4 开发套件之间存在差异。CY8CKIT-049 没有板上编程器，并且需要被引导加载。请参

考 AN73854，了解有关引导加载的详情。要想将本应用手册所提供的示例项目引导加载到 CY8CKIT-049 内，请执行

以下流程： 

1. 将 CY8CKIT-049-4xxx 开发板连接到 PC 上。该套件连接到端口后，请按下 SW1 按键（因为它已经被插入）。您

会看到绿色 LED 开始快速闪烁发亮，表示 PSoC 4 处于‘Bootloader 模式’，并且使用了最新的固件版本进行加

载。每次进行引导加载 PSoC 4 时都需要进行该操作。  

2. 依次选择 Tools > Bootloader Host，以打开 Bootloader 主机工具。 

http://www.cypress.com/
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图 27. 启动 Bootloader 主机工具 

 

打开 Bootloader 主机工具。 

图 28. Bootloader 主机工具 

 

3. 单击 Filters，并从 Port Filters（端口滤波器）窗口内勾选 Show UART Devices 项，然后点击 OK。这样会列出

电脑上连接的所有 COM 器件。  

注意：Bootloader 的 PID 是 F13B。您需要将该 PID 输入到端口滤波器窗口内，这样只会列出套件 Bootloader。 

图 29. 端口滤波器 

 

Bootloader 主机工具会显示所有基于 UART 的可用 COM 端口。 

4. 从可用的端口名单中单击 COM 端口，并且为 USB 串行器件的 USB-UART 配置键入波特率、数据位、停止位和奇

偶校验位等 UART 配置。 

UART 的参数分别为：115200 波特率、8 个数据位、1 个停止位、没有奇偶校验位。 

5. 点击 File > Open，导航到您项目的 CortexM0 文件夹中所生成的 My_First_Project.cyacd 文件，然后点击

Open。 

图 30. 打开所生成的文件 

 

http://www.cypress.com/
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6. 单击 Program 按键，将新的应用代码加载到器件内。状态窗口中将显示输出信息，状态栏则表示编程的过程。 

引导加载操作完成时，应用会执行最新的应用代码。 

图 31. 将应用代码编程到器件内 

 

5.7 更多的 PSoC 4 代码示例 

在赛普拉斯网站上您可以找到更多 PSoC 4 的代码示例。下面提供了 PSoC 4 系列器件中不同模块的综述图。后面的内

容将分别对每个模块的相应代码示例进行介绍。请单击任意 PSoC 4 模块，导航到相应代码示例链接。  

 

5.7.1 CPU — Arm Cortex M0/Cortex M0+ 

PSoC® 4 Arm Cortex-M0 内核是一个低功耗的 32 位 CPU。它拥有一个高效率的三段流水线式、一个固定的 4 GB 存储

器映射，另外还支持 Arm v6-M Thumb 指令集。Cortex-M0 还提供一个单周期的 32 位乘法指令和低延迟的中断处理程

序。紧密与 CPU 内核相连的其他子系统包括：一个嵌套向量中断控制器（NVIC）、一个 SYSTICK 定时器和调试。

PSoC 4000S、PSoC 4100S 和 PSoC 4100S Plus 中的 Arm Cortex-M0+ 是 Cortex-M0 的优化超集（它拥有两段内核

流水线式），这样有助于提高功效。 
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表 5. CPU 子系统的应用手册 

文档编号 文档名称 

AN90799 PSoC® 4 中断 

AN89610 PSoC® 4 和 PSoC 5LP Arm Cortex 代码优化 

 

5.7.2 存储器  — 闪存和 SRAM 

PSoC 4 拥有一个闪存模块，该模块的闪存加速器与 CPU 紧密耦合在一起，以缩短闪存模块的平均访问时间。通过闪

存加速器，闪存的单周期访问时间平均为 SRAM 访问时间的 85%。如果需要，闪存模块的部分空间可以用于仿真

EEPROM 操作。在休眠时仍保持 SRAM 存储器的数据。 

表 6. 仿真 EEPROM 代码示例 

文档编号 文档名称 

CE95313 PSoC 3/4/5LP 的仿真 EEPROM 存储器 

 

5.7.3 DMA 

通过 PSoC 4200L 中 32 个通道的 DMA 引擎，可以实现各个外设间或各存储器间的 32 位传输。 

表 7. PSoC 4 DMA 组件数据手册 

文档编号 文档名称 

001-96043 PSoC 4 存储器直接访问（DMA）通道组件的数据手册 

 

5.7.4 MCA 

马达控制加速（MCA）模块支持马达控制算法中使用的 32 位除法和平方根运算。 MCA 独立于 CPU 运行，因此可以

减少磁场定向控制（FOC）和功率因子校正（PFC）算法的执行时间。 

表 8. 相关应用笔记 

文档编号 文档名称 

001-93637 PSoC® 4 Sensorless Field-Oriented Control (FOC) 

002-04344 FM3 CY9B100A/300A/400A/500A Microcontroller Power Factor Correction 
 

5.7.5 系统资源  — 时钟、RTC、电源系统  

PSoC 4 系统资源包括电源系统、时钟系统、复位和电压参考。电源系统确保通过以下两种方法中的一种能使电压电平

满足相应模式的要求：延迟进入模式（例如，上电复位（POR））直到电压电平满足要求以便能正常工作为止；或生

成复位事件（欠压检测（BOD））或中断事件（低电压检测（LVD））。 

PSoC 4 的时钟系统为需要时钟的所有子系统提供时钟，并且通过该时钟系统可以在各种时钟源之间进行切换而不会造

成短时脉冲。此外，时钟系统可确保不会发生亚稳态条件。PSoC 4200L 的时钟系统包括一个时钟晶体振荡器（即

WCO，工作频率为 32 kHz）、IMO（频率范围为 3 ~ 48 MHz）、ILO 内部振荡器（额定频率为 32 kHz）以及一个备

用的外部时钟。请参考相应 PSoC 4 器件的数据手册，了解芯片上可用的时钟资源。 

表 9. 系统资源的应用手册 

文档编号 文档名称 

AN86233 PSoC® 4 低功耗模式和降低功耗技术 

AN90114 PSoC® 4000 系列低功耗系统设计技术 

http://www.cypress.com/
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文档编号 文档名称 

AN96667 PSoC®基于电源线频率实现实时时钟 

 

表 10. RTC 代码示例 

文档编号 文档名称 

CE96926 PSoC®基于电源线频率实现实时时钟 

CE95915 PSoC® 4100/PSoC 4200 器件中的 RTC 实现 

 

表 11. 系统资源的代码示例 

文档编号 文档名称 

CE95322 PSoC 4 的休眠和唤醒模式 

CE95321 PSoC 4 的休眠和停止模式 

 

表 12. WDT 代码示例 

文档编号 文档名称 

CE95401 PSoC 4 使用 LCD 的看门狗定时器的代码示例 

CE95400 使用 PSoC 4000 的 CY8CKIT-040 中看门狗定时器中断和器件复位 

 

5.7.6 SAR ADC 

12 位的 1M 样本/秒的 SAR ADC 可在 18 MHz 的最大时钟速率下运行，在该频率下进行一次 12 位数据转换至少需要

18 个时钟周期。 

表 13. SAR ADC 应用手册 

文档编号 文档名称 

AN60590 PSoC® 3、PSoC 4 和 PSoC 5LP — 使用二极管测量温度 

 

表 14. SAR ADC 代码示例 

文档编号 文档名称 

CE95275 PSoC 4 中的序列 SAR ADC 和芯片温度传感器 

CE95272 在 PSoC 4 中，SAR ADC 在差分模式下使用预放大器 

 

表 15. PSoC Creator SAR ADC 组件数据手册 

文档编号 文档名称 

001-96792 PSoC 4 序列逐次逼近型 ADC（ADC_SAR_Seq） 

002-16214 PSoC 4 扫描 SAR ADC (Scan_ADC) 

 

http://www.cypress.com/
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5.7.7 CapSense 和 IDAC 

PSoC 4 具有一个 CapSense 模块，用于检测手指触摸。CapSense 模块可用于实现按键、线性和辐射滑条、触控板以

及接近感应传感器等各种用户界面。  

每个 CapSense 模块都包含两个 IDAC，在不使用 CapSense 的情况下，它们可用于通用目的。 

表 16. CapSense 应用手册 

文档编号 文档名称 

AN85951 PSoC® 4 CapSense®设计指南 

AN92239 基于 CapSense®的接近感应 

 

表 17. CapSense 代码示例 

文档编号 文档名称 

CE95297 PSoC 4 中使用了模拟复用器的 1.2 V 比较器（CSD 比较器） 

CE95289 PSoC 4 的 CapSense 接近感应 

CE95288 PSoC 4 的低功耗 CapSense 系统 

CE95286 PSoC 4 中使用调谐器的 CapSense CSD 

CE95285 PSoC 4 中的 CapSense CSD 

CE95327 PSoC 4 中 8 位电流数模转换器（IDAC8） 

 

表 18. PSoC Creator CapSense 和 IDAC 组件数据手册 

文档编号 文档名称 

001-96069 PSoC 4 电容式感应（CapSense® CSD） 

001-96067 PSoC 4 电容式感应（CapSense® Gesture） 

001-96481 PSoC 4 电流数模转换器 

 

5.7.8 可编程模拟模块  — 运算放大器，低功耗比较器，和可编程参考电压 DAC 

PSoC 4 具有支持比较器模式的四个运算放大器，这样能够在片上执行最常见的模拟功能，而无需外部组件。PGA、电

压缓冲区、滤波器、跨阻放大器和其他功能通过使用外部被动组件实现，从而节省功耗、成本和空间。PSoC 4 还具有

一对低功耗比较器，它们可以在深度睡眠模式和休眠模式下工作。这样，当模拟系统模块被禁用时，仍可以在低功耗模

式下监控外部电压电平。PSoC 4100PS 系列器件提供可编程参考电压（PVref），可用于生成多达四个通道的可编程

参考电压； 它还提供一个 13 位电压 DAC（VDAC）。 

表 19. 运算放大器代码示例 

文档编号 文档名称 

CE95341 PSoC 4 的运算放大器（OpAmp） 

CE95340 PSoC 4 中具有动态增益切换特性的放大器 

 

表 20. 比较器代码示例 

文档编号 文档名称 

CE95360 PSoC 3/4/5LP 使用共模的扫描比较器 

http://www.cypress.com/
http://www.cypress.com/documentation/application-notes/an85951-psoc-4-capsense-design-guide?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an92239-proximity-sensing-capsense?source=search&cat=technical_documents
http://www.cypress.com/documentation/code-examples/ce95297-12-volt-comparator-csd-comp-using-analog-multiplexer-psoc-4?source=search&cat=software_tools
http://www.cypress.com/documentation/code-examples/ce95289-capsense-proximity-psoc-4?source=search&cat=software_tools
http://www.cypress.com/documentation/code-examples/ce95288-capsense-low-power-psoc-4?source=search&cat=software_tools
http://www.cypress.com/documentation/code-examples/ce95286-capsense-csd-using-tuner-psoc-4?source=search&cat=software_tools
http://www.cypress.com/documentation/code-examples/ce95285-capsense-csd-psoc-4?source=search&cat=software_tools
http://www.cypress.com/documentation/code-examples/ce95327-8-bit-current-digital-analog-converter-idac8-psoc-4?source=search&cat=software_tools
http://www.cypress.com/?rID=78827
http://www.cypress.com/?rID=105238
http://www.cypress.com/?rID=78752
http://www.cypress.com/documentation/code-examples/ce95341-operational-amplifier-opamp-psoc-4?source=search&cat=software_tools
http://www.cypress.com/documentation/code-examples/ce95340-amplifier-dynamic-gain-switching-psoc-4?source=search&cat=software_tools
http://www.cypress.com/documentation/code-examples/ce95360-scanning-comparator-using-common-mode-psoc-345lp?source=search&cat=software_tools
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文档编号 文档名称 

CE95293 PSoC 4 模拟电压比较器 

CE95338 PSoC 4 的复用模拟比较器 

CE95333 PSoC 4 的低功耗比较器 

 

表 21. PSoC Creator 运算放大器、低功耗比较器和可编程参考组件数据手册 

文档编号 文档名称 

001-92541 PSoC 4 运算放大器（OpAmp） 

001-92647 PSoC 4 低功耗比较器  

001-90677 1.2 V 比较器（CSD Comp） 

002-10611 PSoC 4 可编程电压参考(PVref_P4) 

002-16213 VDAC 组件数据手册 
 

5.7.9 TCPWM 

PSoC® 4 中的定时器、计数器和脉宽调制器（TCPWM）模块能够实现 16 位定时器、计数器、脉宽调制器（PWM）

和正交解码器等功能。该模块用于测量输入信号的周期和脉宽（定时器），捕获特定事件发生的次数（计数器），生成

PWM 信号或解码正交信号。 

表 22. TCPWM 应用手册 

文档编号 文档名称 

AN93637 PSoC® 4 无传感器磁场定向控制（FOC） 

 

表 23. TCPWM 代码示例 

文档编号 文档名称 

CE95354 PSoC 4 的正交解码器 

CE95351 PSoC 4 的固定功能 PWM 

CE95349 PSoC 3/4/5LP 的伪随机序列（PRS）发生器 

CE95385 PSoC 4 的 TCPWM 定时器/计数器操作 

CE95380 PSoC 4 的 TCPWM 配置 

 

表 24. PSoC Creator TCPWM 组件数据手册 

文档编号 文档名称 

001-92448 PSoC 4 定时计数器脉冲宽度调制器（TCPWM） 

 

http://www.cypress.com/
http://www.cypress.com/documentation/code-examples/ce95293-analog-voltage-comparator-psoc-4?source=search&cat=software_tools
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http://www.cypress.com/documentation/application-notes/an93637-psoc-4-sensorless-field-oriented-control-foc?source=search&cat=technical_documents
http://www.cypress.com/documentation/code-examples/ce95354-quadrature-decoder-psoc-4?source=search&cat=software_tools
http://www.cypress.com/documentation/code-examples/ce95351-fixed-function-pwm-psoc-4?source=search&cat=software_tools
http://www.cypress.com/documentation/code-examples/ce95349-pseudo-random-sequence-prs-generator-psoc-345lp?source=search&cat=software_tools
http://www.cypress.com/documentation/code-examples/ce95385-tcpwm-timercounter-operation-psoc-4?source=search&cat=software_tools
http://www.cypress.com/documentation/code-examples/ce95380-tcpwm-configuration-psoc-4?source=search&cat=software_tools
http://www.cypress.com/?rID=78825


  PSoC 4入门 

www.cypress.com 文档编号：001-87170 版本*I 30 

5.7.10 SCB — I2C、SPI、UART 

PSoC 4 有 4 个 SCB，每一个 SCB 都可以实现 I2C、UART、或 SPI 接口。 

表 25. SCB 代码示例 

文档编号 文档名称 

CE96999 PSoC® 4 中基本 LIN 从设备的实现 

CE95325 PSoC 4 的 I2C LCD 

CE95366 PSoC 4 中使用串联通信模块（SCB）进行 UART 发送和接收数据 

CE95365 PSoC 4 中使用串联通信模块（SCB）进行 SPI 发送和接收数据 

CE95364 PSoC 4 中使用串联通信模块（SCB）进行 I2C 从设备操作 

CE95363 PSoC 4 中使用串联通信模块（SCB）进行 I2C 主设备操作 

CE95362 赛普拉斯的 PSoC 4 中使用串联通信模块（SCB）进行 EzI2C 通信 

CE95345 PSoC 4 热管理应用中的 PMBus 从设备 

CE95389 PSoC 3/4/5LP 的 UART 发送操作 

CE95388 PSoC 3/4/5LP 的 UART 接收操作 

 

表 26. PSoC Creator SCB 组件数据手册 

文档编号 文档名称 

001-96075 PSoC 4 串行通信模块（SCB） 
 

5.7.11 UDB 

通用数字模块（UDB）都是可编程数字模块，可将它们用于创建除 PSoC 中已有资源外的自定义数字逻辑。PSoC 

Creator 提供了多个由 UDB 构成的组件（如：PWM、计数器、UART、SPI、I2S）和其他常用的数字模块。 

此外，还可以使用 UDB 创建状态机或自定义通信协议。它们同样可以用于将逻辑门控（如 OR、AND、XOR）添加到

您的设计中。 

PSoC 4 具有八个 UDB；UDB 阵列同样也提供了一个数字系统互连（DSI）结构，允许将外设和端口中的信号布线到

或经过 UDB，以进行通信和控制。 

表 27. UDB 应用手册 

文档编号 文档名称 

AN82156 PSoC® 3、PSoC 4 和 PSoC 5LP — 使用 UDB 数据路径对 PSoC Creator™组件进行设计 

AN82250 PSoC® 3、PSoC 4 和 PSoC 5LP — 使用 Verilog 实现可编程逻辑设计 

AN60024 PSoC® 3、PSoC 4、PSoC 5LP 的开关去抖动和干扰滤波器 

AN62510 使用 PSoC® 3、PSoC 4 和 PSoC 5LP 实现状态机功能 

 

表 28. UDB 代码示例 

文档编号 文档名称 

CE95319 PSoC 3/4/5LP 的硬件短时脉冲滤波器 

CE95348 PSoC 3/4/5LP 的精确照明信号调制（PrISM） 

http://www.cypress.com/
http://www.cypress.com/documentation/code-examples/ce96999-basic-lin-slave-implementation-psoc-4?source=search&cat=software_tools
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http://www.cypress.com/documentation/code-examples/ce95366-uart-transmit-and-receivce-using-serial-communication-block-scb?source=search&cat=software_tools
http://www.cypress.com/documentation/code-examples/ce95365-spi-transmit-and-receive-using-serial-communication-block-scb?source=search&cat=software_tools
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http://www.cypress.com/documentation/code-examples/ce95389-uart-transmit-psoc-345lp?source=search&cat=software_tools
http://www.cypress.com/documentation/code-examples/ce95388-uart-receive-psoc-345lp?source=search&cat=software_tools
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http://www.cypress.com/documentation/application-notes/an82156-psoc-3-psoc-4-and-psoc-5lp-designing-psoc-creator-components?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an82250-psoc-3-psoc-4-and-psoc-5lp-implementing-programmable-logic?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an60024-psoc-3-psoc-4-psoc-5lp-switch-debouncer-and-glitch-filter?source=search&cat=technical_documents
http://www.cypress.com/documentation/application-notes/an62510-implementing-state-machines-psoc-3-psoc-4-and-psoc-5lp?source=search&cat=technical_documents
http://www.cypress.com/documentation/code-examples/ce95319-hardware-glitch-filter-psoc-345lp?source=search&cat=software_tools
http://www.cypress.com/documentation/code-examples/ce95348-precise-illumination-signal-modulation-prism-psoc-345lp?source=search&cat=software_tools
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文档编号 文档名称 

CE95298 PSoC 3/4/5LP 的开关去抖动组件 

CE95294 PSoC 3/4/5LP 的 7 位递减计数器 

CE95334 PSoC 3/4/5LP 的查找表（LUT） 

CE95386 PSoC 3/4/5LP 的 TMP05 温度传感器接口 

 

5.7.12 CAN 

PSoC 4 CAN 外设是功能齐全的控制器区域网络（CAN），能够支持高达 1 Mbps 的通信波特率。PSoC 4200M 和

PSoC 4200L 拥有两个独立的 CAN 2.0B 模块，这两个模块符合 CAN 规范。 

表 29. CAN 代码示例 

文档编号 文档名称 

CE97311 PSoC® 4 M：支持 CapSense®功能的 CAN 单工通信 

 

表 30. PSoC Creator CAN 组建数据手册 

文档编号 文档名称 

001-85034 控制器区域网络（CAN） 

 

5.7.13 通用串行总线  (USB) 

PSoC 4 具有一个全速 USB 2.0 器件接口。该器件拥有一个控制端点和八个其他端点。该接口具有一个 USB 收发器，

并且可以从 IMO 运行而不需要使用晶体振荡器。  

5.7.14 段式 LCD 驱动  

PSoC 4 有一个 LCD 控制器，可驱动多达 8 个 Common 和 56 个 Segment。任何引脚都可以作为一个 Common 引脚

或一个 Segment 引脚。该控制器使用完整的数字方法驱动 LCD 段，而不需要内部生成 LCD 电压。 

表 31. 段式 LCD 应用手册 

文档编号 文档名称 

AN87391 PSoC® 4 段式 LCD 直接驱动模式 

 

表 32. 段式 LCD 代码示例 

文档编号 文档名称 

CE95369 PSoC 4 段式 LCD 

001-88604 PSoC 4 段式 LCD（SegLCD） 

 

5.7.15 通用输入 /输出（GPIO）  

PSoC 4 具有多达 98 个 GPIO，并采用 124 球 VFBGA 封装类型。引脚被分组为逻辑单元（又称为端口），其宽度为 8

位。 

表 33. GPIO 应用手册 

文档编号 文档名称 

AN86439 PSoC® 4 — 使用 GPIO 

http://www.cypress.com/
http://www.cypress.com/documentation/code-examples/ce95298-switch-debouncer-psoc-345lp?source=search&cat=software_tools
http://www.cypress.com/documentation/code-examples/ce95294-7-bit-down-counter-psoc-345lp?source=search&cat=software_tools
http://www.cypress.com/documentation/code-examples/ce95334-lookup-table-lut-psoc-345lp?source=search&cat=software_tools
http://www.cypress.com/documentation/code-examples/ce95386-tmp05-temperature-sensor-interface-psoc-345lp?source=search&cat=software_tools
http://www.cypress.com/documentation/code-examples/ce97311-psoc-4-m-can-simplex-communication-capsense?source=search&cat=software_tools
http://www.cypress.com/?rID=46443
http://www.cypress.com/documentation/application-notes/an87391-psoc-4-segment-lcd-direct-drive?source=search&cat=technical_documents
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表 34. PSoC Creator 引脚组件数据手册 

文档编号 文档名称 

001-92674 引脚 

 

5.7.16 智能 I /O™ 

PSoC 4 拥有一个与其端口相连的智能 I/O 组件，它能够提供置于 GPIO 端口和该端口所连的各种外设和源之间的可编

程逻辑结构。智能 I/O 是开关和 LUT 结构，它允许在路由到 GPIO 端口引脚的信号上执行布尔函数。建议要求在传入

和来自 I/O 引脚的信号执行简单的逻辑操作和进行路由时使用智能 I/O 组件。每个智能 I/O 组件都被连接到一个特定的

GPIO，并且完全占用该端口。如果没有使用该组件，那么可以忽略相应端口的智能 I/O 功能。 

表 35. 智能 I/O 代码示例 

文档编号 文档名称 

CE209974 带有 Smart I/O 的 PSoC® 4 呼吸 LED  

CE209975 带有 Smart I/O 的 PSoC® 4 时钟缓冲器 

CE209976 带有 Smart I/O 的 PSoC® 4 SPI 从设备选择反转 

 

5.7.17 编程和调试  

PSoC 4 编程与调试接口为外部器件提供了一个用于编程或调试的通信网关。外部器件可以是赛普拉斯供应的编程器和

调试器，也可以是支持 PSoC 4 编程和调试功能的第三方器件。串行线调试（SWD）接口用作外部器件与 PSoC 4 间

的通信协议。 

表 36. 编程与调试应用手册 

文档编号 文档名称 

AN84858 使用外部微控制器对 PSoC® 4 进行编程（HSSP） 

KBA93541 使用 CY8CKIT-049 编程其他 PSoC 4 

 

5.7.18 系统级应用手册和代码示例  

表 37. 系统设计应用手册 

文档编号 文档名称 

AN57821 PSoC® 3, PSoC 4 和 PSoC 5LP 混合信号的电路板布局注意事项 

AN81623 PSoC® 3、PSoC 4 和 PSoC 5LP 数字设计最佳实践 

AN88619 PSoC® 4 硬件设计注意事项 

AN2155  PSoC® EMI 设计注意事项 

AN89056 PSoC® 4 — IEC 60730 B 类和 IEC 61508 SIL 安全软件库 

AN80994 PSoC® 3、PSoC 4 和 PSoC 5LP EMC 最佳实践和建议 

 

表 38. 风扇控制器应用手册 

文档编号 文档名称 

AN89346 PSoC® 4 智能风扇控制器 

 

http://www.cypress.com/
http://www.cypress.com/?rID=48513
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表 39. Bootloader 应用手册 

文档编号 文档名称 

AN68272 PSoC® 3、PSoC 4 和 PSoC 5LP UART Bootloader 

AN73854 PSoC® 3、PSoC 4 和 PSoC 5LP 的 Bootloader 的简介 

AN86526 PSoC® 4 I2C Bootloader 

 

表 40. 字符 LCD 代码示例 

文档编号 文档名称 

CE95291 PSoC 4 中使用水平条形图（Hbar）的字符 LCD 

CE95290 PSoC 4 中使用自定义文体的字符 LCD 

 

表 41. 风扇控制器代码示例 

文档编号 文档名称 

CE95318 PSoC 3/4/5LP 中的固件风扇控制 

CE95315 PSoC 4 在自动固件模式下支持警报功能的扇风控制 

 

表 42. Bootloader 代码示例 

文档编号 文档名称 

CE95281 PSoC 4 的 Bootloader 项目 

CE95280 PSoC 4 的 Bootloadable 项目 

 

表 43. 其他代码示例 

文档编号 文档名称 

CE95329 PSoC 4 ILO 调整的补偿 

CE95296 PSoC 3/4/5LP 的循环冗余校验 

CE95379 PSoC 3/4/5LP 中基于软件的 UART 发送操作 

 

表 44. PSoC Creator 系统级组件数据手册 

文档编号 文档名称 

001-92648 Bootloader 和 Bootloadable 组件 

001-85137 中断 

001-96071 PSoC® Creator™系统参考指南（CY_Boot 组件） 
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6 总结 

本应用手册展示了 PSoC 4 架构和开发套件。PSoC 4 是真正的可编程嵌入式片上系统，在同一个芯片中集成了可配置

的模拟和数字外设功能、存储器和 ARM Cortex-M0/M0+微控制器。由于具有集成特性以及低漏功耗模式，PSoC 4 是

低功耗和经济高效嵌入式系统的理想选择。 

此外，本应用手册还为您提供全部资源列表，用以加快深入学习有关 PSoC 4 的知识。 
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